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Healthcare Policy Test Cases
(InfoBeyond Technology LLC)

Abstract

This document demonstrates access control test cases using Security Policy Tool, a software tool for
Access Control Security Managers, Policy Authors, and other IT Security Professionals specializing in the
performance of access control systems. Access control policies are designed to protect the accessibility of
online resources in networks, IoTs, healthcare systems, financial service systems, enterprise IT and clouds,
military systems, and other online environments. There are several challenges in building robust access
control models for these systems including (i) effectively composing secure policies and rules, (ii) testing
these policies systematically, (iii) verifying these policies to prevent access control leaks. Security Policy
Tool solves these issues by providing powerful access control policy modeling, testing, and verification
features that empower organizations to close the door to access control leaks.

Index Terms

Access control, attribute-based access control (abac), role-based access control (rbac), security policy
editing, test, verification, deployment, access control leaks, XACML, software tool.

F

1 INTRODUCTION TO TEST CASES

This document and attached Security Policy Tool – Project Files have been designed to help you
gain an understanding of what common access control errors look like, how they are created, and
how to resolve them. Organizations who leverage Security Policy Tool’s systematic modeling,
testing and verification features are empowered to efficiently identify errors and close the door
to access control leaks.

These Healthcare Policy test cases are based on examples previously created by the National
Institute of Standards & Technology (NIST) to demonstrate commonly found errors in access
control policy logic similarly. These test cases consist of policies/rules from NIST’s example
as well as modifications to better illustrate how Security Policy Tool enhances access control
security. The goal of these test cases is to provide a starting point for what to expect as you go
on to use Security Policy Tool to analyze your own policy verification results for errors.

2 SETTING UP THE POLICIES – TEST CASE 1 (RULE CONFLICT)
This healthcare example contains two policies (ManagerPolicy & DoctorPolicy). The Attribute
/Attribute Values include in these policies are as shown in Figure 1.
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Fig. 1. Test Case 1

3 MODELING YOUR POLICY – TEST CASE 1 (RULE CONFLICT)
Now that we have entered our attributes we can model our two policies (ManagerPolicy &
DoctorPolicy). See the list below of the rules contained in each of these policies. You can open
a “New (blank) Project” and build these policies by entering the following rules below:

ManagerPolicy:
(Subject = Any Value & Manager = doctor 3, View, PatientA OldMedicalRecords) → Permit
(Subject = Any Value & Manager = doctor 3, View, PatientB OldMedicalRecords) →Permit
(Subject = Any Value & Manager = doctor 3, View, PatientC OldMedicalRecords) →Permit
(Subject = Any Value & Manager = doctor 3, View, PatientA PersonalInfo) →Permit
(Subject = Any Value & Manager = doctor 3, View, PatientB PersonalInfo) →Permit
(Subject = Any Value & Manager = doctor 3, View, PatientC PersonalInfo) →Permit
(Subject = Any Value & Manager = doctor 3, View, PatientA PrivateNotes) →Deny
(Subject = Any Value & Manager = doctor 3, View, PatientB PrivateNotes) →Deny
(Subject = Any Value & Manager = doctor 3, View, PatientC PrivateNotes) →Deny

DoctorPolicy:
(Subject = Any Value & Doctor = doctor 1, View, PatientA OldMedicalRecords) →Permit
(Subject = Any Value & Doctor = doctor 1, View, PatientB OldMedicalRecords) →Deny
(Subject = Any Value & Doctor = doctor 1, View, PatientC OldMedicalRecords) →Deny
(Subject = Any Value & Doctor = doctor 1, View, PatientA PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 1, View, PatientB PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 1, View, PatientC PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 1, View, PatientA PrivateNotes) →Permit
(Subject = Any Value & Doctor = doctor 1, Add, PatientA PrivateNotes) →Permit
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(Subject = Any Value & Doctor = doctor 1, Action: Any, PatientB PrivateNotes) →Deny
(Subject = Any Value & Doctor = doctor 1, Action: Any, PatientC PrivateNotes) →Deny
(Subject = Any Value & Doctor = doctor 2, View, PatientA OldMedicalRecords) →Deny
(Subject = Any Value & Doctor = doctor 2, View, PatientB OldMedicalRecords) →Permit
(Subject = Any Value & Doctor = doctor 2, View, PatientC OldMedicalRecords) →Deny
(Subject = Any Value & Doctor = doctor 2, View, PatientA PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 2, View, PatientB PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 2, View, PatientC PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 2, Action: Any, PatientA PrivateNotes) →Deny
(Subject = Any Value & Doctor = doctor 2, View, PatientB PrivateNotes) →Permit
(Subject = Any Value & Doctor = doctor 2, Add, PatientB PrivateNotes) →Permit
(Subject = Any Value & Doctor = doctor 2, Action: Any, PatientC PrivateNotes) →Deny
(Subject = Any Value & Doctor = doctor 3, View, PatientA OldMedicalRecords) →Deny
(Subject = Any Value & Doctor = doctor 3, View, PatientB OldMedicalRecords) →Deny
(Subject = Any Value & Doctor = doctor 3, View, PatientC OldMedicalRecords) →Permit
(Subject = Any Value & Doctor = doctor 3, View, PatientA PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 3, View, PatientB PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 3, View, PatientC PersonalInfo) →Deny
(Subject = Any Value & Doctor = doctor 3, Action: Any, PatientA PrivateNotes) →Deny
(Subject = Any Value & Doctor = doctor 3, Action: Any, PatientB PrivateNotes) →Deny
(Subject = Any Value & Doctor = doctor 3, View, PatientC PrivateNotes) →Permit
(Subject = Any Value & Doctor = doctor 3, Add, PatientC PrivateNotes) →Permit

After entering the rules above your modeled policies should look like the screenshots below. If
you did not create your own Project File, you can simply open Security Policy Tool – Project
File: HealthcareTestCase1 and these policies will have been already created for you.

Fig. 2. ManagerPolicy
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Fig. 3. DoctorPolicy

4 INDIVIDUAL SECURITY REQUIREMENTS - TEST CASE 1 (RULE CONFLICT)
The final step before analyzing these policies for errors is to create individual security require-
ments to use for testing. If you are building a “New (blank) Project” on your own you will enter
the security requirements as follows.

Individual Security Requirements:
(Manager = doctor 3 & Doctor = doctor 3) & (Action = View) & (PrivateNotes = PatientC PrivateNotes) → decision = Permit
(Manager = doctor 3 & Doctor = doctor 3) & (Action = View) & (PatientPersonalInfo = PatientC PersonalInfo)
→ decision = Permit

After entering the rules above your individual security requirements should look like the screen-
shot below. If you did not create your own Project File you can simply open Security Policy
Tool – Project File: HealthcareTestCase1 and these requirements will have been already created
for you.

Fig. 4. Individual Security Requirements
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5 POLICY VERIFICATION/ANALYZING RESULTS - TEST CASE 1 (RULE CONFLICT)
Now that we are ready to test our policies let’s discuss the error we will be looking at in this
first example. When policies are designed, there is potential for a “Rule Conflict” being created.
A Rule Conflict occurs when two or more rules are defining opposite authorization in an access
control policy.

In our example, an individual at this hospital has a role of both doctor and manager at the facility.
Due to this, the individual is assigned both (Doctor: doctor 3 and Manager: doctor 3) attribute
values by the system during access evaluation. In the ManagerPolicy it defines that managers
can view PatientPersonalInfo but cannot view PrivateNotes. However, in the DoctorPolicy the
opposite has been defined (e.g., can view PrivateNotes; cannot view PatientPersonalInfo).

Next, we will run two “Single Policy” Verifications to reveal the Rule Conflict that is present in
our policies. To do this, we will select ManagerPolicy and Test Case 1 (security requirement) as
a Single Policy Verification and also choose DoctorPolicy and Test Case 1 (security requirement)
as a Single Policy Verification and analyze our two verification results. Again, this will have
already been done for you if you open Project File: HealthcareTestCase1.

Fig. 5. ManagerPolicy x Test Case 1

Fig. 6. DoctorPolicy x Test Case 1

As you can see from our verification results our policies are both Permitting and Denying the
individual (Doctor = doctor 3/Manager = doctor 3) from viewing PatientC PersonalInfo and
PatientC Private Notes which is known as a Rule Conflict error.

6 RESOLVING THIS ERROR - TEST CASE 1 (RULE CONFLICT)
To solve a Rule Conflict the policy author would need to go back and either update or delete
the related rules to the error. To view which specific Rules are resulting in these Verification
Results we can click on all (4) of our specific Results (DoctorPolicyxTestCase1: False;True &
ManagerPolicyxTestCase1: True;False) and see which Rules have “Match Results”.



WWW.SECURITYPOLICYTOOL.COM 6

See the screenshots below of our two Policies Match Results to discover which specific rules are
related to our Verification Results (e.g., False, True).

Fig. 7. ManagerPolicy: Match Results (PatientC PrivateNotes)

Fig. 8. ManagerPolicy: Match Results (PatientC PersonalInfo)
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Fig. 9. DoctorPolicy: Match Results (PatientC PrivateNotes)
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Fig. 10. DoctorPolicy: Match Results (PatientC PersonalInfo)

Now that we have pinpointed our (4) Rules related to our Rule Conflict Error we can go back and
make changes or possibly remove these rules. Depending on your organizational structure the
policy author or access control administrator would need to decide what is the most appropriate
action to take to resolve the error. There is no “right” or “wrong” solution for this, you would
need to determine what is most appropriate based on your organizational needs.

For our example, we are going to modify Rule 9 in the ManagerPolicy to Permit “Manager
= doctor 3” to View Patient C PrivateNotes and modify Rule 26 in the DoctorPolicy to Permit
“Doctor = doctor 3” to View Patient C PersonalInfo which will in turn resolve the Rule Conflict.
For this example, we are making an exception for this individual (doctor 3) because they are
required to be able to view PatientPersonalInfo and PrivateNotes to perform their job as a
Manager and a Doctor.

ManagerPolicy: Modify (1) Rule:
(Rule No. = 9) → (Subject = Any Value & Manager = doctor 3) → (Action = View) →(Resource = PatientC PrivateNotes)
→ decision = Permit

DoctorPolicy: Modify (1) Rule:
(Rule No. = 26) → (Subject = Any Value & Doctor = doctor 3) → (Action = View) → (Resource = PatientC PersonalInfo)
→ decision = Permit

Fig. 11. ManagerPolicy: Modified Rule (9)
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Fig. 12. DoctorPolicy: Modified Rule (26)

Which then when we “Refresh” our previous Verification Results we no longer have a Rule
Conflict occurring:

Fig. 13. Updated Results: Manager Policy (No Rule Conflict)

Fig. 14. Updated Results: Doctor Policy (No Rule Conflict)

7 SETTING UP THE POLICIES – TEST CASE 2 (NOT PROTECTED RESOURCE)
This healthcare example contains two policies (ManagerPolicy & DoctorPolicy). The attributes in
this example have been changed slightly from previous Test Case 1. Manager’s attribute value
has been changed from “doctor 3” to “manager” and also OldMedicalRecords has gained a new
attribute value called “PatientD OldMedicalRecords.” The Attribute/Attribute Values include in
these policies are as shown in Figure 15.
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Fig. 15. Test Case 2

8 MODELING YOUR POLICY – TEST CASE 2 (NOT PROTECTED RESOURCE)
Now that we have entered our attributes we can model our two policies (ManagerPolicy &
DoctorPolicy). See the list below of the rules contained in each of these policies. You can open
a “New (blank) Project” and build these policies by entering the following rules below:

ManagerPolicy:
(Manager = manager, View, PatientA OldMedicalRecords) → Permit
(Manager = manager, View, PatientB OldMedicalRecords) →Permit
(Manager = manager, View, PatientC OldMedicalRecords) →Permit
(Manager = manager, View, PatientA PersonalInfo) →Permit
(Manager = manager, View, PatientB PersonalInfo) →Permit
(Manager = manager, View, PatientC PersonalInfo) →Permit
(Manager = manager, View, PatientA PrivateNotes) →Deny
(Manager = manager, View, PatientB PrivateNotes) →Deny
(Manager = manager, View, PatientC PrivateNotes) →Deny

DoctorPolicy:
(Doctor = doctor 1, View, PatientA OldMedicalRecords) →Permit
(Doctor = doctor 1, View, PatientB OldMedicalRecords) →Deny
(Doctor = doctor 1, View, PatientC OldMedicalRecords) →Deny
(Doctor = doctor 1, View, PatientA PersonalInfo) →Deny
(Doctor = doctor 1, View, PatientB PersonalInfo) →Deny
(Doctor = doctor 1, View, PatientC PersonalInfo) →Deny
(Doctor = doctor 1, View, PatientA PrivateNotes) →Permit
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(Doctor = doctor 1, Add, PatientA PrivateNotes) →Permit
(Doctor = doctor 1, Action: Any, PatientB PrivateNotes) →Deny
(Doctor = doctor 1, Action: Any, PatientC PrivateNotes) →Deny
(Doctor = doctor 2, View, PatientA OldMedicalRecords) →Deny
(Doctor = doctor 2, View, PatientB OldMedicalRecords) →Permit
(Doctor = doctor 2, View, PatientC OldMedicalRecords) →Deny
(Doctor = doctor 2, View, PatientA PersonalInfo) →Deny
(Doctor = doctor 2, View, PatientB PersonalInfo) →Deny
(Doctor = doctor 2, View, PatientC PersonalInfo) →Deny
(Doctor = doctor 2, Action: Any, PatientA PrivateNotes) →Deny
(Doctor = doctor 2, View, PatientB PrivateNotes) →Permit
(Doctor = doctor 2, Add, PatientB PrivateNotes) →Permit
(Doctor = doctor 2, Action: Any, PatientC PrivateNotes) →Deny
(Doctor = doctor 3, View, PatientA OldMedicalRecords) →Deny
(Doctor = doctor 3, View, PatientB OldMedicalRecords) →Deny
(Doctor = doctor 3, View, PatientC OldMedicalRecords) →Permit
(Doctor = doctor 3, View, PatientA PersonalInfo) →Deny
(Doctor = doctor 3, View, PatientB PersonalInfo) →Deny
(Doctor = doctor 3, View, PatientC PersonalInfo) →Deny
(Doctor = doctor 3, Action: Any, PatientA PrivateNotes) →Deny
(Doctor = doctor 3, Action: Any, PatientB PrivateNotes) →Deny
(Doctor = doctor 3, View, PatientC PrivateNotes) →Permit
(Doctor = doctor 3, Add, PatientC PrivateNotes) →Permit

After entering the rules above your modeled policies should look like the screenshots below. If
you did not create your own Project File, you can simply open Security Policy Tool – Project
File: HealthcareTestCase2 and these policies will have been already created for you.

Fig. 16. ManagerPolicy
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Fig. 17. DoctorPolicy

9 INDIVIDUAL SECURITY REQUIREMENT - TEST CASE 2 (NOT PROTECTED RE-
SOURCE)
The final step before analyzing these policies for errors is to create individual security require-
ments to use for testing. If you are building a “New (blank) Project” on your own you will enter
the following security requirement below:

Individual Security Requirement:
(Manager = manager) & (Action = View) & (OldMedicalRecords = PatientD OldMedicalRecords) → decision = Permit

After entering the rule above your individual security requirement should look like the screen-
shot below. If you did not create your own Project File you can simply open Security Policy
Tool – Project File: HealthcareTestCase2 and this requirement will have been already created for
you.

Fig. 18. Individual Security Requirement
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10 POLICY VERIFICATION/ANALYZING RESULTS - TEST CASE 2 (NOT PROTECTED
RESOURCE)
Now that we are ready to test our policies let’s discuss the error we will be looking at in this
second example. When policies are designed there is potential for a “Not Protected Resource”
error being created. A Not Protected Resource error occurs when a resource is created but without
protection from any rules.

For example, when the policy author was designing the logic for these healthcare policies; the
author created a resource “PatientD OldMedicalRecords” with no protections. This means there
are not currently any rules defined that are giving a decision for an access request to the resource.
This Not Protected Resource error is not caused by any specific rules in either of our policies; it
is caused due to a lack of rules created to cover this resource.

Next, we will run one “Combined Policy” Verification to reveal the Not Protected Resource error
that is present in our policies. To do this, we will select Test Case 2 (security requirement) and
ManagerPolicy & DoctorPolicy as a Combined Policy Verification and analyze our verification
result. Again, this will have already been done for you if you open Project File: HealthcareTest-
Case2.

Fig. 19. Combined Policy x Test Case 2

By clicking on the Verification Result, we can analyze deeper the reasoning for the “False”
result we have received. Here is where we will notice we have not created Rules attached to
Resource = PatientD OldMedicalRecords. We see this by noticing that every “Match Result” is
“Not Applicable” whereas if there were Rules protecting this resource we would have seen at
least one Rule with a (Permit or Deny) Match Result.
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Fig. 20. Manager Policy: Match Results

Fig. 21. Doctor Policy: Match Results
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11 RESOLVING THIS ERROR - TEST CASE 2 (NOT PROTECTED RESOURCE)
To eliminate a Not Protected Resource vulnerability the policy author would need to define a
specific rule for the unprotected resource (PatientD OldMedicalRecords) and then test again to
verify the intended access decision is being made based on the new rule’s design.

For example, if we’re to add this rule below to the ManagerPolicy. . .

ManagerPolicy: Add (1) New Rule:
(Rule No. = 10) → (Manager = manager) → (Action = View) → (Resource = PatientD OldMedicalRecords) → decision
= Permit

Fig. 22. Manager Policy: New Rule (10)

Then retest using the same Policy Verification selections as last time we will get the same False
Verification result due to our Combination and Enforcement Algorithm selections. However, we
can see in the Match Results that we have provided a rule for the system to evaluate for a
Manager accessing this Resource.

Fig. 23. Updated Policy: Resource Now Protected

12 SETTING UP THE POLICIES – TEST CASE 3 (UNDECIDED RULE)
This healthcare example contains two policies (ManagerPolicy & DoctorPolicy). The attributes in
this example have been changed slightly from previous Test Case 1 and Test Case 2. OldMedi-
calRecords no longer has attribute value “PatientD OldMedicalRecords,” and Private Notes has
gained a new attribute value “PatientD PrivateNotes.” The Attribute/Attribute Values included
in these policies are as shown in Figure 24.
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Fig. 24. Test Case 3

13 MODELING YOUR POLICY – TEST CASE 3 (UNDECIDED RULE)
Now that we have entered our attributes we can model our two policies (ManagerPolicy &
DoctorPolicy). See the list below of the rules contained in each of these policies. You can open
a “New (blank) Project” and build these policies by entering the following rules below:

ManagerPolicy:
(Manager = manager, View, PatientA OldMedicalRecords) → Permit
(Manager = manager, View, PatientB OldMedicalRecords) →Permit
(Manager = manager, View, PatientC OldMedicalRecords) →Permit
(Manager = manager, View, PatientA PersonalInfo) →Permit
(Manager = manager, View, PatientB PersonalInfo) →Permit
(Manager = manager, View, PatientC PersonalInfo) →Permit
(Manager = manager, View, PatientA PrivateNotes) →Deny
(Manager = manager, View, PatientB PrivateNotes) →Deny
(Manager = manager, View, PatientC PrivateNotes) →Deny
(Manager = manager, View, PatientD PrivateNotes) →Deny

DoctorPolicy:
(Doctor = doctor 1, View, PatientA OldMedicalRecords) →Permit
(Doctor = doctor 1, View, PatientB OldMedicalRecords) →Deny
(Doctor = doctor 1, View, PatientC OldMedicalRecords) →Deny
(Doctor = doctor 1, View, PatientA PersonalInfo) →Deny
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(Doctor = doctor 1, View, PatientB PersonalInfo) →Deny
(Doctor = doctor 1, View, PatientC PersonalInfo) →Deny
(Doctor = doctor 1, View, PatientA PrivateNotes) →Permit
(Doctor = doctor 1, Add, PatientA PrivateNotes) →Permit
(Doctor = doctor 1, Action: Any, PatientB PrivateNotes) →Deny
(Doctor = doctor 1, Action: Any, PatientC PrivateNotes) →Deny
(Doctor = doctor 2, View, PatientA OldMedicalRecords) →Deny
(Doctor = doctor 2, View, PatientB OldMedicalRecords) →Permit
(Doctor = doctor 2, View, PatientC OldMedicalRecords) →Deny
(Doctor = doctor 2, View, PatientA PersonalInfo) →Deny
(Doctor = doctor 2, View, PatientB PersonalInfo) →Deny
(Doctor = doctor 2, View, PatientC PersonalInfo) →Deny
(Doctor = doctor 2, Action: Any, PatientA PrivateNotes) →Deny
(Doctor = doctor 2, View, PatientB PrivateNotes) →Permit
(Doctor = doctor 2, Add, PatientB PrivateNotes) →Permit
(Doctor = doctor 2, Action: Any, PatientC PrivateNotes) →Deny
(Doctor = doctor 3, View, PatientA OldMedicalRecords) →Deny
(Doctor = doctor 3, View, PatientB OldMedicalRecords) →Deny
(Doctor = doctor 3, View, PatientC OldMedicalRecords) →Permit
(Doctor = doctor 3, View, PatientA PersonalInfo) →Deny
(Doctor = doctor 3, View, PatientB PersonalInfo) →Deny
(Doctor = doctor 3, View, PatientC PersonalInfo) →Deny
(Doctor = doctor 3, Action: Any, PatientA PrivateNotes) →Deny
(Doctor = doctor 3, Action: Any, PatientB PrivateNotes) →Deny
(Doctor = doctor 3, View, PatientC PrivateNotes) →Permit
(Doctor = doctor 3, Add, PatientC PrivateNotes) →Permit
(Doctor = doctor 3, View, PatientD PrivateNotes) →Permit
(Doctor = doctor 3, Add, PatientD PrivateNotes) →Permit

After entering the rules above your modeled policies should look like the screenshots below. If
you did not create your own Project File, you can simply open Security Policy Tool – Project
File: HealthcareTestCase3 and these policies will have been already created for you.

Fig. 25. ManagerPolicy



WWW.SECURITYPOLICYTOOL.COM 18

Fig. 26. DoctorPolicy

14 INDIVIDUAL SECURITY REQUIREMENTS - TEST CASE 3 (UNDECIDED RULE)
The final step before analyzing these policies for errors is to create individual security require-
ments to use for testing. If you are building a “New (blank) Project” on your own you will enter
the following security requirement below:

Individual Security Requirement:
(Doctor = doctor 1) & (Action = View) & (PrivateNotes = PatientD PrivateNotes) →decision = Permit

After entering the rule above your individual security requirement should look like the screen-
shot below. If you did not create your own Project File you can simply open Security Policy
Tool – Project File: HealthcareTestCase3 and this requirement will have been already created for
you.

Fig. 27. Individual Security Requirement



WWW.SECURITYPOLICYTOOL.COM 19

15 POLICY VERIFICATION/ANALYZING RESULTS - TEST CASE 3 (UNDECIDED RULE)
Now that we are ready to test our policies let’s discuss the error we will be looking at in this
third example. When policies are designed there is potential for an “Undecided Rule” error being
created. An Undecided Rule error occurs when your policy contains rules that are not entirely
defined or missing a step.

For example, when the policy author was designing the logic for these healthcare policies; the au-
thor created rules for Doctor = doctor3 and Manager = manager to access “PatientD PrivateNotes”
but did not define access rules for Doctor = doctor1 and Doctor = doctor2. In this situation, if
doctor1 or doctor2 were to attempt to take action on “PatientD PrivateNotes,” the system would
be forced to make a default decision instead of a defined decision. This may create a security
vulnerability due to your system’s default evaluation decision being different than what you
previously intended. Similar to the “Not Protected Resource” example previously, this error is
caused due to the author missing rules. It is not caused due to flawed interpretation of existing
rules contained in either of our policies as was the case in Test Case 1 (Rule Conflict).

Next, we will run one “Combined Policy” Verification to reveal the Undecided Rule error that
is present in our policies. To do this, we will select Test Case 3 (security requirement) and Man-
agerPolicy & DoctorPolicy as a Combined Policy Verification and analyze our verification result.
Again, this will have already been done for you if you open Project File: HealthcareTestCase3.

Fig. 28. Combined Policy x Test Case 3

Like we did in the “Not Protected Resource” example, by clicking on the Verification Result
we can analyze deeper the reasoning for the “False” result we have received. Here is where
we would notice we have not created Rules that are attached to Subject = doctor 1 taking
action on Resource = PatientD PrivateNotes. We can see this by noticing that every “Match
Result” is “Not Applicable” whereas if there were Rules existing for doctor 1 and Resource =
PatientD PrivateNotes we would have at least see one Rule with a (Permit or Deny) Match
Result.
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Fig. 29. Manager Policy: Match Results

Fig. 30. Doctor Policy: Match Results

As you can see there has not been a rule defined for doctor 1 or doctor 2 → Action
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→ PatientD PrivateNotes which is known as an Undecided Rule error.

16 RESOLVING THIS ERROR - TEST CASE 3 (UNDECIDED RULE)
To solve this error, the policy author would need to define specific rules for all subject at-
tributes (e.g., include doctor 1 and doctor 2) in any policies that handle access requests to
PatientD PrivateNotes. For example, adding the rules below to the DoctorPolicy for our specific
example. . .

DoctorPolicy: Add (4) New Rules:
(Rule No. = 33) → (Doctor = doctor 1) → (Action = View) → (Resource = PatientD PrivateNotes) → decision = Permit
(Rule No. = 34) → (Doctor = doctor 1) → (Action = Add) → (Resource = PatientD PrivateNotes) → decision = Permit
(Rule No. = 35) → (Doctor = doctor 2) → (Action = View) → (Resource = PatientD PrivateNotes) → decision = Permit
(Rule No. = 36) → (Doctor = doctor 2) → (Action = Add) → (Resource = PatientD PrivateNotes) → decision = Permit

Fig. 31. Doctor Policy: New Rules (33,34,35,36)

Now, looking out our Verification results and Match Results we will see that we no longer have
an “Undecided Rule” error occurring. The Verification Result is still “False” due to our choices
in our Combination Algorithm = Deny-overrides and Enforcement Algorithm = Deny Biased.

For example, ManagerPolicy has no rules related to the security requirement (doctor one →
View → PatientD PrivateNotes) we are using for testing which is why see all Match Rules =
Not Applicable. Due to our selection to use Deny Biased for our Enforcement Algorithm the
“Combined Result” for ManagerPolicy = Deny. However, in the case of the DoctorPolicy we
have the Combined Result = Permit due to the new rules we added (e.g., see new Rule 33
below). Hence, we have opposing Combined Results (ManagerPolicy = Deny; DoctorPolicy =
Permit). Finally, the Combination Algorithm = Deny-overrides which makes a definitive answer
for our Verification Results. The Deny-overrides selection overrules the Permit result from the
DoctorPolicy in favor of the Deny result from the ManagerPolicy to make the final Verification
Result = False.
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Fig. 32. Updated Results: No Undecided Rule

17 CONCLUSION

Now you should have a better understanding of what to look for as you go onto verify your
access control policies with Security Policy Tool. In addition to this document there are other
resources located in the Learning Center in your My account page that will help you start
leveraging Security Policy Tool to prevent access control leaks, today!

If you have not yet, download Security Policy Tool – Lite Version for FREE now! Close the door
the Access Control Leaks and save time and cost creating, modeling, testing, and verifying your
access control policies, today.

Click here to begin securing your policies now → Lite Version.

InfoBeyond Technology, LLC is an innovative company specializing in Network, Machine Learning and Data
Security within the Information Technology industry. The mission of InfoBeyond is to research, develop, and
deliver viable software products for network communication and security. Some of our research is sponsored by
Department of Defense, Department of Energy, Missile Defense Agency, Department of Transportation, NIST
(National Institute of Standards and Technology), etc. Security Policy Tool is Awarded the 2017 Innovative Se-
curity Solution Award at the 2017 Big Data and SDN/NFV Summit. NXdrive is a fragment-based cybersecurity
storage system and more information can be found at www.NXdrive.com. The company is featured as one of
50 fast growth IT small businesses in 2017 by The Silicon Review.
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